CDOT Workflow MS 12 Accessing Aerial Imagery Files

Workflow MS 12- Accessing Aerial Imagery Files

This document guides you through the process of locating and downloading aerial imagery
stored on CDOT servers.

Please Note: This workflow has been updated for use with ORD, however, we have included
steps for MicroStation SS4/SS10 as well, to cover the minor differences.

In order to download the correct image files for a project, the names of the image tiles must first
be determined. Both Denver Area (DRAPP) and Statewide (NAIP) image tiles can be identified
using the Imagery Tile Viewer web application.

1. You will need to create an account in GeoHub in order to access the Imagery Tile Viewer
web application (as well as to access all future GeoHub applications). Please follow the
instructions HERE to create your account (must be on the CDOT network or VPN)

2. Once your GeoHub account has been created, you can open the Imagery Tile Viewer
HERE

3. The Imagery Tile Viewer will open as shown below:

This web application can be used to identify and download aerial
imagery tiles.

Click the About button o in the upper right corner of the map for
detailed instructions.

B Do not show this splash screen again.

4. Click the OK button to close the welcome window.
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5. The navigation tools in the upper left corner of the map area allow you to zoom in/out.
The Home button will zoom you to the statewide extent. Scrolling the mouse wheel will
also allow you to zoom in and out. Click and hold the left mouse button down to pan

around the map.
Imagery Tile Viewer

Find address or place ‘ Q ‘

S3E126a

6. Click the Layers List button to display the available data layers.

7. Toturn on a layer in the map area, check the box to the left of the desired layer (i.e. DRAPP
2020). If a layer is grayed out, you need to zoom in to be able to see that layer.

Layer List A X
Layers Q=
’ ooe
» [ Highways oee
’ APP 202 : ooe
o™
‘&
v
v ] State Plane Zones vai
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8. Click the Legend button to see the symbology for the layers that are enabled (checked
on) in the Layers list.

Milepoints

Highways

DRAPP 2020 (Denver Metro)

9. Inthe map area, Left Click on atile grid to select the tile (it will highlight) in order to view its
attributes:
e Type of imagery (i.e. DRAPP 2014 TIF)
e Imagery Directory for that imagery type (i.e.
\\public\Aerials\Aerials_2020\Orthoimagery)
¢ Imagery Tile name (i.e. N1IW133)

Note: Other features such as Highways can also be selected to view their attributes.

| Imagery Directory:
\\public\Aerials\Aerials_2020\Orthoimagery

)
126y,
.. | Image:
"5 S3E126d

|

~4
‘1 Zoomto
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10. Select the imagery directory location in the text box by quickly clicking three times on it until
the entire directory is highlighted. Then Right Click and choose Copy (or hit Ctrl-C on your
keyboard).

| DRAPP 2020

% S8 | Image:
\;‘,\// ‘ stl S3E126d

| Zoomto

11. Open a windows file explorer window by cllcklng the folder icon in your systemtray

H L Type here to search

12. Paste the copied text into the address bar by Right Clicking in the address bar and then
choosing Paste (or Ctrl-V on your keyboard). Then hit the Enter key and you should see the
available sub folders.

| © = | Orthoimagery = o
ey [
r % Cut Y 7 New item + 3 Open £ Selectall
» B[ X v
Copy path % ] Easy access » — Edit Select none
Pinto Quick Copy Paste Move Copy Delete Rename  New Properties )
access # Paste shortcut ¢ to - folder - History Invert selection
liphaazd AL Open Select
< «Ir | \public\Aerials\Aerials_2020\Orthoimagei v|o D Search Orthoimagery
. GoogleDrive (G * A Name Date modified Type Size
Cleanap 3in_Central File folder
QAQC 6in_Central File folder
SB267_Pavement_BridgeCondition 12in_Central File folder

Updates-Spring2021
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13. Back in the Imagery Tile Viewer, highlight the entire image tile name in the text box by
clicking twice on it until the entire name is highlighted. Then Right Click and Copy (or hit
Ctrl-C on your keyboard).

DRAPP 2020

oxefl :
Imagery Directory:
6\\’ \\public\Aerials\Aerials_2020\Orthoimagery

14. In the same windows file explorer pane from earlier steps, paste the copied text into the
search bar. Hit Enter to initiate the search for the image.

< | Orthoimagery

v a
ol s vied
r Cut 17 New item ~ Pl Open ¥ Selectall
ol 0 X & v
W= Copy path % ] Easy access ~ — Edit Select none
Pinto Quick Copy Paste Move Copy Delete Rename  New Properties .
access # Pasteshortcut 1o - folder - History Invert selection
Clipboard Organize New Open Select
<« v 4 > Network > public > Aerials > Aerials 2020 > Orthoimagery v o O S3E126d
« Google Drive (G:) A~ Name Date modified Type Size
Cleanup 3in_Central File folder
QAQC 6in_Central File folder
SB267_Pavement_BridgeCondition 12in_Central File folder

Updates-Spring2021

15. Any files matching the search should display in the window as shown below. Select all found

files and Right Click and Copy (or hit Ctrl-C on your keyboard).

9 v Search Tools

o e Ve | e

Current folder = Fikind~
=

N .
| Al subfolders | Size~

This Date
PC /4 Searchagainin >  modified

Other properties ~ [ Save search

S3E126d - Search Results in Orthoimagery

€ Recent searches ¥ x

[£] Advanced options ~

Openfile  Close
location search

Location Refine Options
- “ A W > SearchResults in Orthoimagery MR O S3E126d

- z:i': DR ** IS ’i S3E1264.tif ‘ Type: TIFFile Date taken: 12/3/2020 10:45 AM

i p = [ open 60 Size: 425 MB
7 S3E126d.tfw | Create a new video Date modified: 12/1/2020 10:33 PM
SB267_Pavement_BridgeCondition Pt ek ok OB Eot st Phops Size: 41 bytes
Updates:Spring2021 Set as desktop background
@ OneDrive Pant

I Rotate right

2 30 Objects Rotate left

B Desktop Cast to Device >

% Documents ) Convert to Adobe PDF

4 Downloads 1 Combine files in Acrobat...

J Music & Edit with Notepad-++

& Pictures & Share

B Videos E snagit >

25 Windows (C) 9 WinZip >

- Google Drive (G:) Always available offline

- dtddata (\public) (N:) i N

- dtdimagery (\public) (X:) =

» _ROWFiles_processing (\\public\dtdimagery\ROWFiles) (Y:) 'E:;y—]

~ DTDImages (\\10.35.11.235) (Z)

Create shortcut
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16. Open a new windows explorer pane and navigate to the desired location on your local
machine, then Right Click in the windows explorer pane and choose Paste (or Ctrl-V
on your keyboard).

17. Repeat above steps for any other files needed.
Tips/Tricks:
¢ Occasionally when you access the Imagery Tile Viewer, you may be prompted

to sign in again. Please click the blue Enterprise Login button, which should
sign you in automatically.

Enterprise login

Colorado Department of Transportation (CDOT)

e You can change the base map if desired by clicking the Basemap Gallery button
and choosing the desired basemap.
Imagery Tile Viewer

S3E116d

S3EM6C S3E17c

Silver LOYEY.
Heights * ey s

 S3E1250 \ < s8E126a

S3E127a i (SIE!
} %,

¢ If you have multiple layers turned on and you try to click on a grid to get the
image tile attributes, be aware that you might have multiple features selected. If
you see 1 of “X” in the upper left corner of the info box, you can click the arrow to
the right to display the other selected feature’s attributes.

DRAPP 2014 TIF

Imagery Directory:
\tecaenals\Aenals_2014\uncompressed

[mage:
S1wW374

Zoom o Get Directions
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e Some help content is available by clicking the Help button.

National
Grasslands

This web application can be used to identify and download
DRAPP and NAIP aerial imagery tiles.

1.Zoom in on the map or use the Find Address box to
locate your eree of interest.

2. Nextturn on the desired imagery layer in the Layers

widiet.

e Be aware that each NAIP TIFF will have one of two projections (UTM 13N
NAD83 or UTM 12N NADB83) depending on where in the state it is located. This
can be determined in the file name (12 or 13). The following western Colorado
counties are UTM12N NAD83: Delta, Dolores, Garfield, La Plata, Mesa, Moffat,
Montezuma, Montrose, Ouray, Rio Blanco and San Miguel. The rest are UTM
13N NADS83.

Colorado Department of Transportation



CDOT Workflow MS 12

Attaching Image Files To A DGN File

Accessing Aerial Imagery Files

The following steps describe how to attach image files copied from the server to a DGN
file and apply the proper geographic coordinate system associated with the images to

the DGN file.

Note: Whether you are using MicroStation SS4/SS10 or OpenRoads Designer (ORD)
and are working locally or on the ProjectWise Cloud, the following steps are the same,

regardless of the application.

1. Create a new file using the 2D seed file.

a New - C:\Projects\CDOT Imagery Workflow\ X
Save in: | * CDOT Imagery Workflow vl (< A g ?j &
* Name - Date modified Type Size
: * Ms12 Accessing Aerial Imagery Files Workfl...  7/29/2021 9:25 AM File folder
Quickaccess  =M)15ges Example.dgn 7/29/2021 9:11 AM DGN File 209 KB
- ﬂlmages.dgn 7/29/2021 8:56 AM DGN File 60 KB
Desktop
= |
Libraries
This PC
Net-work
File name: I PCH# Specialty-Group Image VI
Save as type: MicroStation DGN Files (*.dgn) v Cancel
Seed: Ilesigner CE\Conﬁgura’(ion\Organizakion-Gvil\CDOT_Standards\.Se{i\ZD»Seed_C DOT.dq T

2. Set the Level for the DGN file to DRAFT _Image. The illustration below show how to set
the level in ORD. Be sure the workflow is set to Drawing and use the Home tab.

x4 Drawing ol tT240%-

Home View Annotate Attach Analyze Curves Constraints Utilities Drawit
& None * | Default E a l[w ? : ;J Y * ey : i
[s0 |20 = Level Filter: (none) e % v %] N SEelleeTt?cr;; Al 1!'

Attri L Ty Selectio
_:l:. ;:/ © X [33319.072  DRAFT_Corridor-Template Dr B a
..... P DRAFT_Corridor-Transition - | [ |
Q - = DRAFT_Corridor-Transition - | (2 [
27 I.mammy e — —— = 5 RNl ol fre
¢ DRAFT_Image | O

[gﬂ' URAFI_Information-No Plot ] L

,@, DRAFT_Matchlines dh =
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The illustration below shows how to set the level in the MicroStation SS series.
Mq C\Projects\CDOT Imagery Workflow\JPC22_Specialty-Group_mageryS54.dgn [2D - \

File Edit Hement Settings Tools Survey Suface Geometry Evaluation Drainag

&~ |[Defaut = IEY R =R
| DRAFT_CO-White
[ a::si‘lm

N
o
10
>

Draft_Image
AR TNy rhaaen
Tasks | DRAFT_INFO_No-Flot
7> cin DRAFT_INROADS_Notes
DRAFT_LC-Center WT-0
E {"| DRAFT_LC Center_WT-3
1 E-I-* DRAFT_LCContinuous_\WT-0
% 2+ HDRAFT_LCContinuous_WT-3
DRAFT_LC-Dashed_WT-0
2 Analy DRAFT_LC-Dashed_WT-3
DRAFT_LC-Divide_WT-D
it Gene|DRAFT_LC-Divide_WT-3
—| DRAFT_LC-Dotted_WT-0
“~ HOMZ{npArT | C-Dotted_WT-3
| DRAFT_LC-Hidden_WT-0
BB Vertid o AFT LCHidden WT-3

R L T 1Y
000000000000 COdoO
OO0DO0dOO0O0OoOOoOEOnd

€

Once you have set the level to DRAFT_Image, open the Raster Manager as shown
below.

Important Note: If you are working from ProjectWise, for images that have Sister
Files, you must check out the sister file prior to proceeding with the following steps.

For ORD, From the Drawing workflow > Home tab > Primary section > Attach Tools >Raster
Manager:

&4 IDrawing Ao HE B TE2200& s C:\Projects\CDOT It
File View Annotate Attach Analyze Curves Constraints Utilities Drawing Aids Content

= =2 HRTY 2
N ~ | [DRAFT 2 [ k Ik b S8 :
@& None _image Q 8 Gy beeed /[I
i = = =7~ = | Fence
o -|[Z0 ~|[=o -|@o ~|[&go -] Elor Seicion @ Took~ ) Smant
Attributes ‘ [E] References Selection
""" Properties v X Point Clouds
e 45 Bxts vmm,cnormo
> — @) Reality Mesh ~ O
rn| &y e, EE e
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For the MicroStation SS series:

4.

5.

Colorado Department of Transportation

B4 C:\Projects\CDOT Imagery Workflow\JPC##_Specialty-Group_ImageryS54.dgn [2D - V8 DGN] - Power InRoads V8i (SELECTseries )
* Fle Edit Hement Settings Tools Survey Suface Geometry Evaluation Drainage Drafting Quantities Power InRoads Tools Utiities Workspace Window Subsurface

@ v | [Draft_image vJ@O v:;o v‘zo viao v‘@ 0 v v@@vgvﬁv év
\:IGT D :\T O“ :‘h 88‘&‘& E:’ 22 D%I‘ L ‘Q_. Raster Manager

e :
i v ¥ X [ View, Coor Defauie

In the Raster Manager dialog box, Select File > Attach >Raster.

EH Raster Manager: 0 of 0 listed - X

File IEdit View Display Settings Tools Utilities

3 v i e - LH Lix
i B2 8o 549 B
tta
= =i Description B Model
Detach 5§ WMS...
Detach All From Image Server...
Reload ““§ ECWP Image Server...
Save As.. Bing Maps...
h§ Attach Raster Grid
Export 4
Import 4

Batch Convert

TIEIEI-‘-&ISIBI?IS = @ R Tine D Transparency:-

In the Attach Raster Reference dialog box, navigate to the folder containing the images. Select
only the *.tif image file, make sure Open Settings Dialog is toggled on, then click the Open
Button.

&) Attach Raster Reference 'Y
4 I % < CDO.. » MS12 Accessing Aerial Imagery Files Workflow u... ..I [ 2 Search MS12 Accessing Aeri...
Organize = New folder = | 0
S
[ Desktop A Name Date Type Size Tags
Documents S IE11Ih Hy 1642001 10.00 Akt IEEl LB
& Downloads | EEE 1/14/2021 1:15 PM TIF File 435,739 KB |
b Music ] S2E126d.tfw 112 AM TFW File TKB
&) Pictures (24 5261264 i 1AM TIF File 435,736 KB
8 Videos
- 05(C)
File = Open Read-Only
Directory ¥ Place Interactivel
[ Open Settings Dialog
File name: | 52E112b.tif v‘ All Files (*.7) ~
[ o ]| cnee
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Note: If you are working in ProjectWise the Attach Raster Reference dialog box looks the image

below. Highlight the desired file, Left Click the Add button, then, Left Click the OK button.

<
Select
Doaments
Folder | [ Dranvings fE = |
R Ml
1 m_3910557_ne_73_050_20190922.44
< amec T xaml
/) m_3910557 _ne_13 05020190922 t#.ovr
/) m_3910557_ne_13_050_20190922 txt
< >
Apphcation: Al Applcations ¥
Exterson: Al documents v
E
dd l=mgye
B
Selected Documents, check mark enly
Name
&1 m_3910557_ne_13 050 20190922.4%
< >

=

6. This displays the Raster Attachment Options dialog box. For DRAPP images in the Geometry

tab, select Sister File.

| & Raster Attachment Options - [m] x|
o5
B C:\Projects\CDOT Imagery Worlkflow'\MS12 Accessing Aerial Imagery Files Workflow update\S2E112b tif
|
| Action ~ General A
|| Placeinieractively  No Level |
! Color |
Line Style
‘Weight
Class
Pricrity
Image ~ Color -~
Logical Name Tint [ [255.255.255]
{ Description Contrast 0
| Brightness 0
Invert Do Not Invert Display
Transparency Hide

Display Print - Extended

Colorado Department of Transportation

Cancel
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For NAIP images, select Raster Header for the GeoPriority. Set the Inherit GeoCS from Model to
Not Inherited.

£ Raster Attachment Options - m] X
[ER-] itachment
i C:\Projects'\CDOT Imagery Workflow\NAIP-20210805T142443Z-001\NAIP\m_3910557_ne_13_060_20190922f
Action -~ General -~
Place Interactively No Level DRAFT_Image
Celor i Bylevel
Line Style BylLevel
‘Weight BylLevel
Class Primary
Image ~ Color ~
Logical Name Tint [ [255.255.255]
Description Contrast 0
EBrightness 0
Invert Do Not Invert Display
Transparency Hide
Display Print v Extended ~
Snappable Snappable
Locked Unlocked
Geometry ~
Geo Pioity EErTa—
Inherit GeoCS from Modg|Net Inherited
Attach Cancel

7. Repeat steps 4 through 6 for all images to be attached.

The next steps are used to assign the imagery’s geographic coordinate system to the DGN file.

8. From the Drawing workflow > Utilities tab > Geographic section, select Geographic System tool.

Cllloewing o HEB -+ 22t @& - C:\Projects\CDOT Imagery Workflow\JPC## Specialty-Group_Imagery.dgn [2D - V3 DGN] - OpenRoads Desi
File Home View Annotate Attach Analyze Curves Constraints. Drawing Aids Content Help cpar
{3 MDL Applications Y r| B | by e Record m Ston 2 C=B) 73 % ‘& %k amn B8 @
oolf JE:«jed QCIDSETDDIBDXES D‘: CEEJE & i E _4. o (A - .‘=‘= i g | LuSSumey Foot
T Bt @ Connect to Browser play Convert Capture =] # ViewControl | Manager Co Initialize Signatures Slgezltlure CoS;r;ElEr::te & @) US Survey Inch
Utilities Image Macros F] Design History F] Security Geegraphic Drawi
3t & |1 X[1os1041627 Y [537

Colorado Department of Transportation

15



CDOT Workflow MS 12

The same tool is found in the MicroStation SS series as shown below:

agery Workflow\JPC##_Specialty-Group_lmagery554.dgn [2D - V& DGM] - Power InRoads V8i (SELECTse

=ttings l|| Tools

i 00 3
koo &l fz“i.i' Activate Map

= 1 & = &l | )

Accessing Aerial Imagery Files

luation Drainage Drafting Quantties Power InRoads

v Aftrbutes
TR TRIEE
v Standard

L= Default

Product Add-Ins y o

Dete.n. g Sy »
Dimensions 3
o
v | Geographic P {23 1 Select Geographic Coordinate System
roups £ Global Posttioning System
Levels ¥ & 3 Expoit Google Earth (KML) File
¥ Manipulate * e 4 Capture Google Earth Image
Measure P & 5 Define Placemark Monument
Mesh P ## & Synchronize Google Earth View
MuttiHines Y% 7 Folow Google Earth View
Parametrics } iz 8 Google Earth Settings
Patteming * @9 9 Play Camera Animation in Google Earth
Paint Cloud »| 4] 0 Open Location in Google Maps
Project Navigation 1= T T
Properties
X

Raster 3

= Redline 3
Reference » |Geagraphic

* v Security - ~
Selection :IEBIfV@l;@in‘IgL?EB@b]
T i u

Note: The following steps apply to both ORD and the MicroStation SS series.

9. Inthe Geographic Coordinate System tool settings box, select the From Library icon.

10. In the Select Geographic Coordinate System dialog box, expand Favorites and
Colorado Projected. Select the appropriate coordinate system for your image file. In

this example, the image is in the Colorado Central Zone, so CO83-CF is used as shown

below:

Current Geographic Coordinate System
Name:  <MNone>
Description:

Source:

54 Select Geographic Coordinate System

Library ISEarCh
e
211 Favorites

Colorado - Projected fnorthing, easting N.)

Colorado Department of Transportation

1=# CO-C - NAD27 Colorado State Plane, Central Zone(502), US Foot
O-N - NADZ7 Colorado State Plane. Noth Zone(501), US Foot

LS MADDT Colocade Giate DL ih 5030 LIS Eoot
083CF - NAD23 Colorado State Plane, Central Zone, US Foot

= Olorado Siate Tiane, Hor e, o
083-5F - NAD23 Colorado State Plane, South Zone, US Foot

083C - NAD83 Colorado State Plane, Central Zone, Meter

083N - NADE3 Colorado State Flane, North Zone, Meter

5 CO83-5 - NADS3 Colorado State Plane, South Zone, Meter
083/2011-CF - NSRS11(NADE3/2011) Colorado, Central Zone, US Foot

1 CDOT-Projects

Library
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NAIP TIFF will have one of two projections (UTM 13N NAD83 or UTM 12N NAD83)
depending on where in the state it is located. This can be determined in the file name
(12 or 13). The following western Colorado counties are UTM12N NAD83: Delta,
Dolores, Garfield, La Plata, Mesa, Moffat, Montezuma, Montrose, Ouray, Rio Blanco and

San Miguel. The rest are UTM 13N NADS83.

These can be found using the search as shown below:

&1 select Geographic Coordinate System — O X
Library I Search I
Search Text JUTM 13N NADE3
(®) Any Wword () Al words
Ky Name Descintion | It ~
[ EPSG:26913 NADE3 / UTM zane 13N Meter
SR KL MEDdCone 7 M zone 130 Meter
EP5G:3743 NADBIHARN) / UTM zone 13N Meter
UTME3-HA-13 Higher Accuracy UTM with NADB3 datum, Zone 13, Meter METER
UTM33-13 UTM with NAD83 datum, Zone 13, Meter; Central Meridian 105d W METER
i e+t e P
Add To Favarites Properties. .
0K Cancel

Note: The coordinate systems for both the DRAPP and NAIP images can be found in
both the Colorado - Projected and the DRAPP & NAIP — Coordinate Systems for

CDOT Imagery folders.

Once the coordinate system file has been assigned, it is shown in the Geographic Coordinate
System tool settings box.

11.

U Geographic Coordinate Systern — X
CER N g el

Current Geographic Coordinate System
Mame: CO83-CF

Description:  MADE3 Colorade State Plane, Central Zone
Source:  Calculated from CO823-C by Mentor Softwi

The new image design file is now ready to be used with Project Plan files by referencing it using the
Geographic Reprojection option so that it aligns with the Project Specific Coordinate System set by the
Survey Team in the survey file deliverable for this project. More details on reprojection are explained in
workflow MS 24 Assigning Project Coordinate System.

Colorado Department of Transportation
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